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Email Client Settings - The Basics

The following settings must be checked within an email client so an email account will work with the
new email infrastructure.

e The username format is the full email address. This is the login portion that is located along with
the subscriber’s password.

e |nthe images, your_domain.com is the part of your email address that follows the"@" sign.

e The new incoming mail server for (POP 3) & (IMAP) is now “mail.newdaybb.net”.

e The new outgoing mail server (SMTP) is now “mail.newdaybb.net”.

e "Qutgoing server requires authentication" needs to remain checked.

e Uncheck "This server requires a secure connection (SSL)"

e |tis highly recommended that only one protocol is used to access the mailbox, either POP or
IMAP when using multiple devices such as PCs, cell phones and tablets.



Outlook 2013

1. Open Outlook

2. Click the File tab

3. Select Account Settings

4. On E-mail tab select account and click
Change

5. Change the following:

Incoming mail server: mail.newdaybb.net
Outgoing mail server

(SMTP): mail.newdaybb.net

Require logon using Secure Password
Authentication (SPA): Leave this option
unchecked.

6. Click More Settings

7. Select the Outgoing Server tab

Verify My outgoing server (SMTP) requires
authentication is checked and select Use same

settings as my incoming mail server.

_Q'LH
Account
Settings ~

.
Account Settings =

E-mail Accounts
You can add or remove an account. You can select an account and change its settings.

E-mail |Data Files | RSS Feeds | SharePoint Lists I Internet Calendars I Published Calendars | Address Books |

o New... ‘$¥Repair... 5 Change... % Remove
[ Name Type
Change Account R
POP and IMAP Account Settings
Enter the mail server settings for your account.
User Information Test Account Settings

Your Name: We recommend that you test your account to ensure that

the entries are correct.

First Last
Email Address: username @your_domain.co

Server Information

Account Type: POF3

st medivecoer @;u{t‘?cc::(a\\ytut account settings when Next
Outgoaing mail server (SMTP):

Logon Information

User Name:

Username@your_domain.ca

Passward:
[¥]Remember password

[ Require logon using Secure Password Authentication

=> More Settings ...

Internet E-mail Settings 2 &=

Qutgoing Server | Advanced

My autgaoing server (SMTP) requires authentication
@ Use same settings as my incoming mail server

Lag on using

Remember password
Require Secure Password Authentication [SPA])

Log on to incoming mail server before sending mail

Ok ] [ Cancel




8. Click the Advanced tab

9. Click the Use Defaults button

10. Click OK

11. Click Next

12. Click Finish

Internet E-mail Settings

| General I Outgoing Server| Advanced |

Server Port Numbers

Incoming server (POP3): 110 Use Defaults

|:|This server requires an encrypted connection (35L)

Outgoing server [SMTPF: 25

Use the following type of encrypted connection: |None |Z|

Server Timeouts

Short  ~J Long 1 minute

Drelivery

Leave a copy of messages on the server
Remo\te from server after 14 2| days

|:| Remove from server when deleted from 'Deleted Items’

ok || Cancel




Outlook 2007
1. Open Outlook.

2. Click the Tools menu, and select Account
Settings...

3. On the E-mail tab, select your POP
account and click Change...

4. Change the following fields:
POP/IMAP server: mail.newdaybb.net
SMTP server: mail.newdaybb.net
Require logon using Secure Password
Authentication (SPA): Leave this option
unchecked.

5. Click the More Settings... button

6. Select the Outgoing Server tab.

7. Verify My outgoing server (SMTP)
requires authentication is selected and
select Use same settings as my incoming
mail server.

8. Click the Advanced tab

9. Enter 110 in the Incoming Server (POP3)
or 993 if the Incoming Server is (IMAP)
10. Uncheck This server requires an

encrypted connection (SSL).

11. Enter 25 or 587 in the Outgoing Server
(SMTP)

12. Use the following type of encrypted
connection should be set to None.

13. Click OK
14. Click Next

15. Click Finish

Change E-mail Account

Internet E-mail Settings
Each of these settings are required to get your e-mail account working,

User Information Test Account Settings

After filing out the information on this screen, we
recommend you test your account by dicking the
button below. {Requires network connection)

Your Name: [Your Name |

E-mail Address:

‘ — Test Account Settings ...
mail your_damain.com ¢

Logon Information

Server Information
Account Type:

Incoming mail server:

User Mame:

@your_domain.com

Password:

Remember password

[]Require logon using Secure Password Authentication (SPA)

e [ pore Setings ..

£

Internet E-mail Settings

General | Outgoing Server | Connection || Advanced

My outgeing server (SMTP) requires authentication;
@ Use same settings as my incoming mail server

O Log on using
| |

() Log on to incoming mail server before sending mail

Ok H Cancel ]

Internet E-mail Settings

General | Outgoing Server Connecﬁon| Advanced |

Server Port Numbers
Incoming server (POP3): Use Defaults
E‘\is server requires an enaypted connection (S5L)

Qutgoing server {(SMTP): -

Use the following type of encrypted connection:

Server Timeouts
Short 7

Long 1minute
Delivery

[CJLeave a copy of messages on the server

[ =]

COK l [ Cancel




Outlook Express

1. Open Outlook Express. ¥ username@your_domain.com Properties

Z-Geneml-i Servers | Connection || Security | Advanc:ed-i

2. Click the Tools menu, and select Accounts...

Server Infomation

My incoming mail serverisa |POP3 ] SErVer.

3. Click the Mail tab, select your POP account and Incoming mail (POP3): | mail.your_domain.com i ey

click Properties. Outgoing mail {SMTP): | mail your_domain.com @
Incoming Mail Server -

4. Click on the Servers Tab and change the Agsourt name: [vsermame@yeur_domai.com |

following fields: Bassword: =3 |

Remember password
[ Log on using Secure Password Authentication

POP/IMAP server: mail.newdaybb.net

SMTP server: mail.newdaybb.net e
utgoing Mail Server

Verify My server requires authentication is [Z] My serer requires authentication EES
checked A

u oK ] [ Cancel ]
5. Click the Advanced tab. 2 username@your_domain.com Properties E|E|

.Geneml | Servers 'Connec‘tion. Security

6. Enter 25 or 587 in the Outgoing Server
(SMTP)

Server Port Numbers -

Qutgaing mail (SMTP): !_25 _! Use Defaults

. . is server reguires a secure connection {S5L0)
7. Uncheck This server requires an encrypted E-h —

. Incoming mail (FOP3): |11 |
connection (SSL).

(e |

(his server requires a secure connection (SSL)

Server Timeouts

8. Enter 110 in the Incoming Mail (POP3) or 993 if it e L

1 minute
the Incoming Server is (IMAP) :
Sending
[ Break apart messages langer than ! : : KE
9. Uncheck This server requires an encrypted .
elivery

connection (SSL).

[ Leave a copy of messages on server

10. Click OK.

[ ok [ cancel | [ aepty |




Windows Mail
1. Open Windows Mail.
2. Click the Tools menu, and select Accounts...

3. Click the Mail tab, select your POP account
and click Properties.

4. Click the Servers tab and change the
following fields:

POP/IMAP server: mail.newdaybb.net
SMTP server: mail.newdaybb.net

Verify My server requires authentication is
checked

5. Click the Advanced tab.

6. Enter 25 or 587 in the Outgoing Server
(SMTP)

7. Uncheck This server requires an encrypted
connection (SSL).

8. Enter 110 in the Incoming Mail (POP3) or 993
if the Incoming Server is (IMAP)

9. Uncheck This server requires an encrypted
connection (SSL).

10. Click OK.

| General | Servers |Connection I Security I Advanced

Server Information

My incoming mail server is a POP3 SErVer,

Incoming mail (POP3): mail.your_domain.com

Qutgoing mail (SMTP):  mail.your_domain.com

Incoming Mail Server
E-mail username: username@your_domain.com
Password: LI
[¥] Rernember password
[7] Leg on using Secure Password Authentication
Outgoing Mail Server

My server requires authentication

<=
<=

ox ) o ) o]
| General I Servers I Connection I Securi’ry| Advanced |
Server Port Numbers
Outgeing mail (SMTP): Use Defaults
Ehis SENVEr requires a secure connection (55L)
Incoming mail (POP3): 110
Ehis SENVEr requires a secure connection (55L)
Server Timeouts
Short T Long 1 minute
Sending
[] Break apart messages larger than 60 KB
Delivery
[7] Leave a copy of messages on server
Remove from server after 5
Remove from server when deleted from 'Deleted lterns
0K || cancel |[ ety |




Thunderbird 3
1. Open Thunderbird.

2. Click the Tools menu, and select Account
Settings...

3. Click Server setting in the left-hand pane.

4. Enter mail.newdaybb.net in the Server
Name field

5. Enter 110 in the Port field

6. Click Outgoing Server (SMTP) in the left-
hand pane.

7. Select your account and click Edit...

8. Enter mail.newdaybb.net in the Server
Name field.

9. Enter 25 or 587 in the Port field.

10. Under Security and Authentication put a
check mark in Username and password.

11. Click the Connection security dropdown
and select none.

12. Click OK in the SMTP Server window

13. Click OK in the Account Settings window

Account Settings

Junk Settings
Disk Space

= username @vour_domain.com
Server Settings
Copies & Folders
Composition & Addressing
Junk Settings
Disk Space
Return Receipts
Security

Qutgoing Server (SMTP)

(=l Local Folders

&9

POP Mail Server
]Eurt:l 110 :ll:refault: 295

O — |

Server Type:

server Name: fl|mail.your_domain.com

User Name: username@your_domain

Security Settings

Connection security: \ none
D Use secure suthentication
Server Settings

Check for new messages at startup

Check for new messages every | 0E ‘ minutes

Automatically download new messages
[ Fetch headers only

[] Leave messages on server

[] Empty Trash on Exit

Local directory:

| C:\Documents and Settings\Administrator | | Browse |

Account Actions -

(=l Local Folders
Junk Settings
Disk Space

=) username @your_domain.com
Server Settings
Copies & Folders
Composition & Addressing
Junk Settings
Disk Space
Return Receipts
Security

Qutgoing Server (SMTP)

Outgoing Server (SMTP) Settings

Although you can specify more than one outgeing server (SMTP}, this is only
recommended for advanced users, Setting up multiple SMTP servers can cause errors
when sending messages,

| smtp.gmail.com (Default) Add
SMTP Server & (e
Settings ailes
Description:

Server Name:

mail.your domain.com I

= > Port: L

| Defauit: 465

Security and Authentication
Use name and password

User Name: | username@your_domair

[ Use secure authentication

Connection security: \none |

Account Actions %




Apple Mail
1. Open Apple Mail.
2. Click Mail, and select Preferences...

3. Open the Accounts tab and select
your existing account in the left panel.

4. Change the Incoming Mail Server to:
mail.newdaybb.net

5. At the bottom of the right panel click
the arrow to the right of Outgoing Mail
Server (SMTP) and click “Edit SMTP
Server List ...” from the dropdown.

6. Under Account information please
enter the Server Name as:
mail.newdaybb.net

7. Click the Advanced tab

8. Verify Use default port (25, 465, 587)
is selected

*If you get an error, or have issues
sending, please change to “Use custom
port:” and set to 587

9. Uncheck Use Secure Sockets Layer
(SsL)

10. Click OK

10

anea Accounts

T £ ( o Kl
L MO el A L L e
General Accounts RSS  Junk Mail Fonts & Colors Viewing Composing Rules

Accounts

[ Account Information  Mailbox Behaviors  Advanced

Account Type: POP
Description: username@your_domain.com
Email Address: username@your_domain.com

Full Name: Your Name

Incoming Mail Server.l mail.your_domain.com I

User Name: username@your_domaincom

Password: esssssssse

Outgoing Mail Server (SMTP):  mail.your_domain.com !

# Use only this server

(.
(v
.

 Advanced |

Description: | mail your_domain.com |

Server Name: |mail.v0ur_duma'm.cum |

@ | Cancel | (0K

Description Server Name In Use By Account

mail.your_domain.com  mailyour_domzin.com  Your_Domain

Account Information | Advanced |

(® Use default ports (25, 465, 587)
() Use custom port:

$ __Use Secure Sockets Layer (S5L)

Authentication: | Password T]
User Name: [ username@your_domain.com
Password: [n-.".u.
©) (cancel ) (C ok )




11. On the Account page select the
Advanced tab

12. Enter 110 in the Port field

| Accounts ] -—( Account Information ~ Mailbox Behaviors | Advanced }—-
‘ usernamef@w...
POP E Enable this account
13. Uncheck Use SSL '
E Include when automatically checking for new messages
E Remove copy from server after retrieving a message:
14 Verlfy Authentication iS setto [ After one week I‘-‘ (_R.emave nuw)
Password Prompt me to skip messages over E KB

Check with your system administrator before changing
any of the advanced options below:

m: [ 110 | L] Use SSL appgiemmmy

Authentication: [ Password Hd

15. Close the window to save

| Accounts ] -—{ Account Information ~ Mailbox Behaviors | Advanced }—-
‘ usernamef@w...
pOP  Enable this account

E Include when automatically checking for new messages

g Remove copy from server after retrieving a message:

[ After one week I‘-ﬂ (_R.emwe now )

Prompt me to skip messages over E KB

Check with your system administrator before changing
any of the advanced options below:

m: [ 110 L) Use SSL ety

Authentication: [ Password hﬁd

11



Apple Mail 8.2

1. Open Apple Mail.

2. Click Mail, and
select Preferences...

3. Open the Accounts tab and select
your existing account in the left
panel.

4. Change the Incoming Mail Server
to: mail.newdaybb.net

5. At the bottom of the right panel
click the arrow to the right of
Outgoing Mail Server (SMTP) and
click “Edit SMTP Server List ...” from
the dropdown.

6. Under Account information
please enter the Server Name as:
mail.newdaybb.net

7. Click the Advanced tab

8. Verify Use default port (25, 465, 587)
is selected

*If you get an error, or have issues
sending, please change to “Use custom
port:” and set to 587

9. Uncheck Use Secure Sockets Layer
(SSL) and set Port to 25 or 587.

10. Place a check in the box that states
Allow insecure authentication

11. Verify the Username has your full

email address and your Password is
entered. Click OK.

12

@ A = /S O i

General Accounts Junk Mail Fonts & Colors Viewing Composing Signatures Rules

- e Mailbox Behaviors

Accounts

Enable this
Account Type: POP

Description: Your_Domain

account

Advanced

Email Address:  youremail@your_domain.com

Full Name:  Your Name

Incoming Mail Server:
User Name:  youremail

Password: sesses

Outgoing Mail Server (SMTP): mail.your_domain.com (Oﬂlin(E

Use only thi

S server

TLS Certificate: = None E
+ —
?
+ J—
ACCO Informatio Advanced
Description: | mail.your_domain.com
Server Name: mail.your_domain.com
TLS Certificate: = None E
? Cancel OK
l—
Account Information Advanced
Automatically detect and maintain account settings
Port: 25 Use SSL
Authentication: = Password [T
Allow insecure authentication
User Name: youremail@your_domain.com
Password: esesese
‘ Cancel | (LS



12. On the Account page select the LA J Accounts

Advanced tab B @ A o / Q- >

General Accounts Junk Mail Fonts & Colors Viewing Composing Signatures Rules

Account Information  Mailbox Behaviors [at o)

13. Enter 110 in the Port field

Automatically detect and maintain account settings
Include when automatically checking for new messages
Remove copy from server after retrieving a message:

14 Uncheck Use SSL After one week B Remove now
Prompt me to skip messages over KB
. . . . Check with your system administrator before changing
15. Verlfy Authentication is set to any of the advanced options below:
Password Port: 110 [ Use SSL
Authentication: = Password B
16. Place a check in the box that Allow/Sescure aithentication
states Allow insecure
authentication
alE=

@ I ® Accounts
=

17. Close the window to save B @ o A g B O _ﬁ?._*
General Accounts Junk Mail Fonts & Celors Viewing Composing Signatures Rules

Example . Account Information Mailbox Behaviors

Automatically detect and maintain account settings

Include when automatically checking for new messages
Remaove copy from server after retrieving a message:

. After one week E . Remove now

Prompt me to skip messages over KB

Check with your system administrator before changing
any of the advanced options below:

Port: 110 | []UsesSsL

43

Authentication: | Password

m Allow insecure authentication

13




